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ProVal version 2.23 June 2005 

ProVal version 2.23 introduces new ways to view and edit library entries, service definitions to explicitly 

handle plans with fractional service accruals, and parameterized calculation of accrual rates for 

nondiscrimination testing. You’ll find details about these and other enhancements below. 

 
Interface 

 In ProVal libraries, you can now: 

o Erase or hide multiple entries at once.  To 

select multiple entries, hold the Shift or Ctrl 

key down while clicking with the mouse. 

 

o Sort library entries by name or date last 

modified – e.g., to quickly find the entry you 

last worked on. 

  

o Rename entries without opening them. 

o Make a copy of an entry (avoiding the 

practice of editing an entry, saving it as new, 

and then editing the new entry). 

o Quickly scroll to an item by typing the first 

few letters of its name without pausing. 

 New  buttons let you create and unhide 

reference tables from within Valuation and 

Projection Assumptions.  Look for these “edit” 

buttons throughout ProVal to edit nearly 

anything from within another library. 

 A new List Objects command (on the File menu) 

lets you list the entire inventory of objects in the 

current client. 

 When pasting into a spreadsheet that allows row 

insertion (e.g., increase rate tables), ProVal will 

now automatically insert new rows as needed to 

accommodate the data. 

Pension Plans 

 Service definitions are now available to handle 

plans with fractional service accruals (e.g., 

hours-related service) and rounding rules (e.g., 

completed years, completed months, etc.).  

Service definitions can be used to define benefit 

eligibility service, benefit accrual service, and 

more. 
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 Service definitions can be found (along with the 

existing libraries for Census Specifications and 

Salary Definitions) under Input > Census. 

 

 In Benefit Component Tables > Calculate 

Annuity Factors > Joint & Survivor Annuities, a 

new checkbox lets you calculate J&S conversion 

factors in a single table (i.e., Life Annuity / 

J&S).  This is particularly useful for REA death 

benefit payment forms. 

 

Nondiscrimination Tests 

 The calculation of accrual rates, with and 

without adjustment for permitted disparity, has 

now been parameterized.  This avoids the 

previous practice of using several valuation runs 

and expression sets to calculate accrual rates. 

See Nondiscrimination Tests, page 7  

 

Public Pension Plans 

 In the GASB Accounting topic of an Asset & 

Funding Policy, if Normal Cost + Supplemental 

Cost is chosen as the ARC contribution policy, 

you can now specify amortization parameters 

different than funding for calculating the 

supplemental cost and Net Pension Obligation. 

 

 A new exhibit for valuation sets and 

deterministic forecasts details the GASB 25 

annual required contribution policy. 

OPEB Plans 

 In valuation assumptions, you now have a 

choice of how to adjust claims to mid-year (or to 

year-end).  You separately decide whether to 

apply: 

o Interest discount (ProVal’s previous 

behavior),  

o Mortality discount, and/or  

o Increase rates (e.g., trend) 

 



What’s New, ProVal version 2.23 - 3 - June 2005 

 GASB 43/45 parameters are now available in 

OPEB Asset & Funding Policies to specify the 

ARC contribution policy, any existing Net 

OPEB Obligation (NOO), and the aggregate 

method NOO amortization approach. 

See GASB for OPEB Plans, page 8  

All Plans 

 Subformula benefit formula components can 

now reference other subformula components 

(except for circular references, of course). 

Output & Reporting 

 A valuation set’s results can now be written to 

an Access database to facilitate report writing.  

(This was actually released as a special update to 

version 2.22, but is included here in case you 

missed it.) 

See Saving Exhibits to Access, page 5  

 When viewing output, the name of the output 

style you’ve loaded (if any) now appears on the 

listing. 

 A new option lets you choose whether to list 

inputs above or below the numeric results in 

valuation and core projection output (placing the 

inputs above the numeric results replicates the 

behavior in ProVal version 2.21 and earlier). 

Census Data 

 Spreadsheet Edit and Print Data now display the 

number of selected records you are viewing. 

 

 Character key fields (actually any field type) can 

now be used everywhere a key field is required 

in ProVal.  This expands the types of key fields 

that can be used in Compare Database Files, 

Status Reconciliation, and Individual Results. 

 If ProVal finds unknown codes in an import file 

that resemble, but don’t exactly match, existing 

labels in the data dictionary, you can now 

choose how to treat them:  map to existing labels 

or add them as new. 

 

Tools 

 PIA Calculations:  You can now run a group of 

individuals (no longer just a single individual) 

and save the resulting PIA back to the database. 

 Populate ProVal PS:  If you connect to the 

internet through a proxy server, you might have 

previously had trouble purchasing a ProVal PS 

license.  ProVal’s internet settings now support 

more complex proxy server setups. 

System 

 Network administrators can now pack client 

files (both library and database files) outside of 

ProVal through a .BAT file.  The sample batch 

file "Autopack0.bat" is provided as a starting 

point. 

 Regulatory data (i.e., maximum benefits, 

maximum compensation, etc.) is now distributed 

in a version-independent way (text files named 

RegMaxBen.txt, RegMaxComp.txt, etc. stored 

in the ProVal folder). This means updated 

regulatory data will no longer drive the decision 

to adopt a new version.  WinTech will distribute 

updated regulatory data through 

www.winklevoss.com/wintech/updates/proval/ 

as it becomes available (typically late October or 

early November).  

Changes Log 

 Be sure to read the changes log (see What’s New 

in Help or the CHANGES.LOG file in the 

ProVal directory) about updates to certain 

calculations that may change results. 

http://www.winklevoss.com/wintech/updates/proval/
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500 West Putnam Avenue 
Greenwich, CT  06830 
 
tel:   (203) 861-5530 
fax:  (203) 861-5531 
email:  support@winklevoss.com 
website:  www.winklevoss.com 

 

ProVal PS is a desktop toolkit for sponsors of 

defined benefit and medical plans, populated by the 

ProVal results that you generate.  Since the last 

release of ProVal, you can now brand the home page 

of ProVal PS (for files that you populate) with your 

own logo, links to your website, etc.  Simply provide 

us with your logo and describe any other 

customizations and we’ll take it from there. 

 

New Members of the ProVal 
Team 

Hank Freeman recently joined the ProVal 
team.  He is an experienced consulting 
actuary and will be heading up WinTech’s 
Virtual Back Office (see sidebar to the left).  
He also plans to steer ProVal PS to new 
heights.  Be sure to say hello to him if you 
reach him at ProVal support. 

Pallav Ray recently joined the ProAdmin 
team.  He has experience programming DB 
administration systems and web sites.  He is 
currently taking on technical responsibilities 
for ProAdmin’s Plan Participant Web Site. 

Xiaoling Zhang recently joined the ProVal 
team.  She has a PhD in statistics and 
Canadian actuarial consulting experience.  
She will be programming actuarial features 
for ProVal. 

WinTech’s Virtual Back Office 

Need help bringing up new clients, 
converting cases, or experienced help in a 
ProVal area that’s new to you?  Why not call 
upon WinTech’s experienced actuaries to fill 

in?  Contact Hank Freeman at (203) 861-

5526 for details or to request a quote. 
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Saving Exhibits to Access 
You can now save valuation set exhibits and deterministic forecast exhibits directly to a Microsoft Access 

database.  The database is intended to be used by other programs, such as report writers.  In addition to exhibits, 

the database also contains summary output, like that available in Valuation Set Output and Deterministic Forecast 

Output.  Although you can save multiple run’s results to a single database, it is recommended that only one run’s 

results be written per database. 

To save exhibits to an Access database: 

 View Valuation Set Exhibits or 

Deterministic Forecast 

Exhibits  

 Click the File… button  

 Type in a filename and choose 

Access database (*.mdb) as the 

file type  

 Click the Save button  

Database structure 

The database contains the following tables: 

 ProVal_ValSet_Params.  Basic information about the valuation set(s) or deterministic forecast(s) in the 

database, including the valuation 

date and measurement date.  

 ProVal_ValSet_Data.  Summary 

output, like that available in 

Valuation Set Output or 

Deterministic Forecast Output.  

Liability splits are included for 

actives in total, actives by 

decrement (retirement, 

termination, death, disability, and 

employee contributions), 

inactives in total, and inactives 

by status (retired, terminated, 

disabled, and survivor).  

 ProVal_*.  Valuation Set 

Exhibits data.  For instance, the table ProVal_USMin contains the development of the minimum 

contribution.  Only the exhibits you’ve selected are saved (exception:  the Schedule of Active Participant 

Data exhibits cannot be saved to an Access database).  Note that many valuation interest rates can be 

found in the exhibits.  For a complete list of exhibit table names, see Exhibit Names in Word and Access 

in ProVal’s help (Help > Help Topics > Command Reference > Output Menu > Valuation Set Exhibits). 

 ProVal_ValSet_Events.  Basic information about the event columns in the ProVal_* exhibit tables 

mentioned above.  You will only have more than one event if you’ve elected to display exhibits by 

valuation event. 
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To facilitate use by other programs such as report writers, many elements in the database are stable.  That is, they 

won’t change from one ProVal version to the next, unless necessary, such as to incorporate a law change.  The 

stable elements are: 

 Table names (e.g., ProVal_ValSet_Params)  

 Field (i.e., column) names.  These are meant to be used for column lookups.  

 The Name field in each table.  This is meant to be used for row lookups.  

 Not the Description field in each table.  This is meant to improve the readability of the database when 

viewed with human eyes.  The descriptions might change from time to time and should not be used by 

outside programs. 

Alternative:  Collection of CSV Files 

If you would rather use CSV files instead of an Access database, choose Collection of CSV Files (filename*.csv) 

as the file type.  Each of the database tables listed above will be saved to a separate .csv file.  Each file will be 

prefixed by a filename that you provide.  For example, if you provide the filename “val2005”, ProVal will save 

files named “val2005ProVal_ValSet_Params.csv”, “val2005ProVal_ValSet_Data.csv”, etc. 
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Nondiscrimination Tests 
The calculation of accrual rates, with and without adjustment for permitted disparity, has now been parameterized.  

This avoids the previous practice of using several valuation runs and expression sets to calculate accrual rates.  

While parameterization cannot replace knowledge of the nondiscrimination rules, the tool should provide some 

framework for users who are less familiar with the rules.  The parameters are designed to handle the majority of 

“usual” situations.  To handle exceptional situations, ProVal still allows the import of accrual rates from other 

sources (e.g., from an Excel file). 

Performing nondiscrimination tests in ProVal is a two step process: 

 

 Accrual Rates.  A new tool that allows for 

the parameterized calculation of unadjusted 

accrual rates (i.e., before adjustment for 

permitted disparity) for defined benefit and 

aggregate defined benefit/defined contribution 

plans under the annual, accrued-to-date, and 

projected calculation methods on either a 

benefits or contributions basis.  In addition, 

permitted disparity information is calculated. 

The results are saved to a database for input 

into the Coverage and General Tests tool 

below. 

 

 Coverage and General Tests.  This is 

ProVal’s existing nondiscrimination 

testing tool with a new option to adjust 

accrual rates for permitted disparity.  

The unadjusted accrual rates and 

permitted disparity information 

calculated in the Accrual Rates tool 

above are inputs into this tool.  

 

 

 

For details, see Help articles on these tools (Help > Help Topics > Command Reference > Tools Menu). 
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GASB for OPEB Plans 
In 2004, the GASB issued: 

o Statement 43, Financial Reporting for Postemployment Benefit Plans Other Than Pension Plans, and 

o Statement 45, Accounting and Financial Reporting by Employers for Postemployment Benefits Other 

Than Pensions 

requiring Public Plans and Employers to disclose their OPEB obligations beginning after December 15, 2005.  

GASB 43/45 reporting is comparable to public plan pension reporting under GASB 25/27, not FAS 106.  The 

same liabilities are used for funding and GASB accounting, so only a funding valuation is (generally) necessary. 

The key reporting elements that 

are within the scope of ProVal are 

the Annual Required Contribution 

(ARC) and the annual OPEB cost.  

These calculations are 

parameterized in the Accounting 

Methodology topic of the Asset & 

Funding Policy (choose Expense 

calculations under “GASB 

43/45”.). 

o The ARC (for details, see 

the exhibit on page 10) is 

computed per the selected 

ARC Contribution 

Policy, where four (4) 

options are currently 

available.  Note that this 

can differ from the employer’s Contribution Policy as specified in the Contribution Policy topic, which 

for example, might include additional contributions to pay off any Net OPEB Obligation. 

The underlying actuarial cost method (for both the ARC contribution policy and employer’s contribution 

policy) is specified in the Contribution Policy topic.  ProVal supports five of GASB’s six acceptable 

methods.  The following GASB names correspond with ProVal’s Cost Methods. 

GASB name ProVal Cost Method  

Entry age Entry Age 

Frozen entry age Frozen Entry Age (FIL) 

Attained age <not supported> 

Frozen attained age FIL with PUC 

Projected Unit Credit (or Unprojected Unit Credit if 

past service benefits are not affected by future salary 

levels) 

Projected Unit Credit (PUC) 

Aggregate Aggregate 
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o The annual OPEB cost (for details, see the exhibit on page 10) is generally equal to the ARC.  However, 

if employer contributions have historically differed from the ARC (current year differences aren’t 

reflected until the following year), a Net OPEB Obligation (NOO) is established.  The annual OPEB cost 

is then adjusted by interest on the NOO and an amortization of the NOO.  In a forecast, the Net OPEB 

Obligation reflects differences, if any, between the ARC contribution policy and the employer’s 

contribution policy. 

All GASB Asset & Funding Policies now require that funding amortization parameters be set in the Funding 

Amortization Policy topic.  (Previously they were only required for “Normal Cost + Supplemental Cost” 

contribution policies.)  The amortization information is necessary to calculate an appropriate Annual OPEB Cost. 

If a “Normal Cost + Supplemental Cost” ARC contribution policy is selected in the GASB Accounting 

Methodology topic, you may elect to Use Funding Amort. Bases, or enter different GASB amortization 

parameters (click the Params… button to see the dialog shown below).  This determines the ARC supplemental 

cost and the Net OPEB Obligation amortization.  The ability to specify separate GASB amortization parameters 

has also been added to Public Pension mode. 

 

Information about any existing Net OPEB Obligation (NOO) is also specified as part of the GASB Accounting 

Methodology topic.  If a Current Net OPEB Obligation (NOO) exists, it is entered along with the (preliminary) 

remaining amortization period(s).  The NOO amortization period may be overridden if an open amortization 

period is used for ARC supplemental cost or if an aggregate actuarial cost method is used (see below).  Per GASB 

45, the annual OPEB cost is adjusted by the discounted present value of the Net OPEB Obligation at the 

beginning of the year using the same amortization methodology used in determining the ARC for that year.   

The accounting methodology dialog also controls the NOO amortization under aggregate funding methods.  

(That is, if the actuarial cost method specified under the Contribution Policy topic is aggregate.)  The amortization 

is equal to the NOO divided by either: 

1) The ratio of the present value of future lives to the number of valuation actives (with no interest adjustment), 

which produces the same effective amortization as the FIL level dollar method. 

2) An annuity factor for a period equal to the FASB definition of expected average service to retirement.  (An 

“accounting” valuation is required to calculate this amortization period, and rounding options are provided.) 

3) An annuity factor with a user-specified amortization period. 
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Finally, Valuation Set and Deterministic Forecast Exhibits have been added that detail the Annual Required 

Contribution (new in the Public Pension mode as well) and the development of the Net OPEB Obligation, 

including any adjustments required to meet the GASB minimum amortization requirements. 

GASB 43/45: Development of ARC (Normal Cost + Supplemental Cost) 

1. Assumptions  

  (a) Funding interest rate 8.00% 

  (b) Amortization payment increase rate 0.00% 

  

2. Preliminary Annual Required Contribution (ARC)  

  (a) Normal cost 121,990 

  (b) Term cost N/A 

  (c) Administrative expenses 0 

  (d) Supplemental cost  

   (i) Funding liability 3,811,274 

   (ii) Actuarial assets 2,000,000 

   (iii) Outstanding Balance: (i)-(ii) 1,811,274 

   (iv) Years to run 5 

   (v) Supplemental cost 420,042 

  (e) BOY contribution: (a)+(b)+(c)+(d)(v) 542,032 

  (f) Contribution timing  

   (i) Fraction to year end: 0.5000  

   (ii) Compound interest to year end at rate (1)(a) 21,264 

  (g) Preliminary ARC: (e)+(f)(ii), not less than 0 $563,296 

  

3. Minimum Annual Required Contribution  

  (a) Normal Cost 121,990 

  (b) Term cost N/A 

  (c) Administrative expenses 0 

  (d) Unfunded Liability 1,811,274 

  (e) Minimum supplemental cost 148,973 

  (f) Minimum ARC: (a)+(b)+(c)+(e), not less than 0 270,963 

  (g) Contribution timing  

   (i) Fraction to year end: 0.5000  

   (ii) Compound interest to year end at rate (1)(a) 10,630 

  (h) Minimum ARC adjusted for timing: (f)+(g)(ii) 281,593 

  

4. Annual Required Contribution: max of (2)(g) and (3)(h) $563,296 

 

GASB 45: Development of Annual OPEB Cost and Net OPEB Obligation (NOO) 

1. Funding interest rate 8.00% 

  

2. Net OPEB Obligation (NOO) as of January 1, 2000 $0 

  

3. Annual Required Contribution (ARC) 563,296 

  

4. Interest on NOO at rate (1) to December 31, 2000 0 

  

5. Amortization of Net OPEB Obligation 0 

  

6. Annual OPEB Cost: (3)+(4)-(5) $563,296 

  

7. Annual Employer contribution 563,296 

  

8. Change in Net OPEB Obligation: (6)-(7) $0 

  

9. Net OPEB Obligation as of December 31, 2000: (2)+(8) $0 
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